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1 Getting Started
Bio-Plex Data Pro™ software provides tools for annotating and analyzing the results 
of experiments conducted in Bio-Plex Manager™ software. When you import 
Bio-Plex Manager data into Bio-Plex Data Pro, you can edit samples, view results, 
and perform statistical analysis on data. These actions take place within a Bio-Plex 
Data Pro project.

The following two tutorials will get you started with Bio-Plex Data Pro. 

 An Introduction to Bio-Plex Data Pro Software

Start with this tutorial to get an overview of Bio-Plex Data Pro, how to navigate 
through the application and familiarize yourself with the different features of the 
software.

 Analyzing Your Data

This tutorial walks you through the steps beginning with importing your data 
into Bio-Plex Data Pro to interpreting the results of your experiments.

An Introduction to Bio-Plex Data Pro Software

This section introduces you to Bio-Plex Data Pro. It takes you through and gives you 
an overview of the product.
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1  |  Getting Started
1. Start Bio-Plex Data Pro.

The Home view appears. In this view, you can create a new project or open an 
existing project. The navigation bar in the left pane displays the project 
workflow, starting at the top with Manage Data Sets and ending with Perform 
Analysis/Create Charts.
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An Introduction to Bio-Plex Data Pro Software
2. Click Sample Project 1 to open the example project shipped with Bio-Plex Data 
Pro.

The Manage Data Sets view displays the data sets in your project. 
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1  |  Getting Started
3. Select one of the data sets and right-click to open the context menu.

 You can choose Edit Data Set to open the Edit Dataset dialog box, where 
you can edit the description of your data set.

 You can choose Delete Data Set to remove a data set from your project.
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An Introduction to Bio-Plex Data Pro Software
4. Click Perform Analysis/Create Charts in the navigation bar. 

In this view, you visualize your results and view the results of common 
calculations.

Note: In order to view results that are meaningful, you must label your 
samples with information from your experiment. This is done in the Edit 
Samples/Add Columns view.

Data Outputs

There are six types of data outputs. Click on the buttons in the toolbar to display 
your data in the desired output.
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1  |  Getting Started
Scatter Plot  — shows the results by biological replicates using the 
parameter you choose to draw your comparisons. The scatter plot allows you to 
view one analyte or multiple analytes.
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An Introduction to Bio-Plex Data Pro Software
Box and Whisker Plot  — shows the results by biological replicates using the 
parameter you choose to draw your comparisons. It displays pertinent statistical 
information for one or more analytes.
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1  |  Getting Started
Bar Graph  — shows the results by biological replicates using the parameter 
you choose to draw your comparisons. You can select as many analytes as you like 
from the Analyte Table for comparison.
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An Introduction to Bio-Plex Data Pro Software
Summary Table  — displays common calculations for your biological 
replicates.

Export to Statistics Software  — displays the sample information used to 
generate the other outputs in a format that is convenient for import into statistical 
software packages.
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Sample List  — represents the data in the Results Table section. This can be 
used to reproduce the scatter plots in Microsoft Excel.
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An Introduction to Bio-Plex Data Pro Software
5. Notice the “Compare by” and Control dropdown lists.

Compare by — changes how samples are grouped on the x-axis of the graphs 
and grouped for analysis in the summary table.

Control — chooses the biological replicate group for your experiment. This 
group is plotted on the left side of the graphs and results in the P-value for the 
pair-wise statistical tests being presented in the relevant views.

Compare by  
and Control 
dropdown lists
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6. Click Edit Samples/Add Columns in the navigation bar. 

In this view, you see a list of every sample in your project. Each sample is 
created from samples identified in Bio-Plex Manager software. In this view, you 
add specific information from your experiment.
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An Introduction to Bio-Plex Data Pro Software
7. Click View Results/View Heat Map in the navigation bar. 

In this view, you can do the following and view your results:

 Filter your results by removing samples that meet specific criteria

 Sort your data and export tables

 Create heat maps of your results or custom tables
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Sample Projects

Bio-Plex Data Pro comes with two sample projects. Use these sample projects to 
familiarize yourself with Bio-Plex Data Pro. The following is a description of these 
sample projects.

Sample Project 1

The samples in Sample Project 1 are of individuals who have been diagnosed with 
various cancers and whose blood was processed as serum and plasma. The gender 
of the individuals is known. This project includes several custom columns:

 Condition — the values are Normal or one of several cancers.

 Matrix — the values are Serum or Plasma.

 Gender — the values are Male or Female.

In the Perform Analysis/Create Charts view, “Compare by” is set to Condition. The 
Plasma samples are excluded from analysis by default. You can click “Filter by” and 
select Matrix to see the list of samples.

The Sample Info section of Bio-Plex Manager is used to track all of the information 
that is pertinent to your experiment (in this example, Condition, Matrix, and Gender). 
When you begin working with your own projects, you will need to add the data you 
want to use to perform your analysis.

Sample Project 2

The samples in Sample Project 2 were labeled as Normal, Breast Cancer, Lung 
Cancer, Colon Cancer, Ovarian Cancer, and Prostate Cancer. In the Perform 
Analysis/Create Charts view, “Compare by” is set to Description. Labeling samples 
with informative descriptions in Bio-Plex Manager can eliminate the need to label 
samples in Bio-Plex Data Pro if the experiment is relatively simple. In this example, 
we were interested only in whether the samples came from patients diagnosed with 
a specific type of cancer or were free of any cancer.
14  |  Bio-Plex Data Pro Software User Guide



Analyzing Your Data
Analyzing Your Data

This tutorial describes how to take data from Bio-Plex Manager and analyze it using 
Bio-Plex Data Pro. The tutorial consists of the following steps:

 Step 1: Analyze Your Data in Bio-Plex Manager Software

 Step 2: Bio-Plex Data Pro Software Workflow

 Step 3: Import Your Data into Bio-Plex Data Pro Software

 Step 4: Select Your Samples

 Step 5: Label Your Samples

 Step 6: Filter Your Data

 Step 7: View Your Data in the Results Table

 Step 8: The Perform Analysis/Create Charts View

 Step 9: Analyze Your Data in Bio-Plex Data Pro Software

Step 1: Analyze Your Data in Bio-Plex Manager Software

Before you use Bio-Plex Data Pro, first analyze the results of your run in Bio-Plex 
Manager. Bio-Rad recommends you do the following:

1. Run the Curve Fit Optimizer for all curves.

This algorithm optimizes most curves to create as broad a dynamic range as 
possible.

2. Review the messages in your optimization report.

3. Visually inspect your curves and ensure that your data are acceptable for your 
purposes.
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Step 2: Bio-Plex Data Pro Software Workflow

The basic workflow in Bio-Plex Data Pro consists of the following steps:

1. Create a project.

2. Import your data sets (Bio-Plex Results files [.rbx]).

3. Edit your samples.

4. View your results.

5. Analyze your data.

This guide explains how to use Bio-Plex Data Pro to perform the steps in this 
workflow.

Step 3: Import Your Data into Bio-Plex Data Pro 
Software

There are two methods for transferring your data into Bio-Plex Data Pro:

 If you are viewing your results in Bio-Plex Manager 6.1, you can use the 
Export Results to Bio-Plex Data Pro function. The data are seamlessly 
exported from Bio-Plex Manager and imported to Bio-Plex Data Pro. You 
can create a new project and import the data into it, or you can import the 
data into an existing project. For more information, see Importing Data 
Directly from Bio-Plex Manager Software on page 48.

 Create a new project and import data files in Bio-Plex Data Pro. For more 
information, see Importing Data into Bio-Plex Data Pro Software on 
page 46.

Step 4: Select Your Samples 

The results files that are imported into Bio-Plex Data Pro contain different sample 
types. Typically, Standard and Blank samples are unnecessary and, sometimes, 
confusing. By default, these sample types are automatically excluded. Click Select 
Sample Type for Analysis to see how these sample types are filtered out. You can 
always include them by selecting them for inclusion.
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Step 5: Label Your Samples

Before you can analyze your data, you must first label your samples with data from 
your experiments that are pertinent to your analysis. Sometimes the information 
entered in the description is sufficient to carry out the desired analysis, but usually 
you need to annotate your data.

1. Open your project, then click Edit Samples/Add Columns  in the 
navigation pane.

2. Click Add Column  in the toolbar to add a column to the table for 
each of the parameters you want to track for analysis.

These parameters can be experimental group (for example, Dosage, 
Concentration, or Time Point) or demographic (for example, Gender, Species, 
Strain) information.

3. Add sample data to the column by copying and pasting from a Microsoft Excel 
spreadsheet.

You can arrange the order of the columns by clicking the header and dragging the 
column to a new location in the table.

Step 6: Filter Your Data 

You can control the samples that are included in your analysis by filtering your data. 

Filters can be cleared at any time by clicking the Clear All Analysis Filters button.

The next two steps describe in greater detail how to use the filter tools:

 Step 7: View Your Data in the Results Table and

 Step 8: The Perform Analysis/Create Charts View 
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Step 7: View Your Data in the Results Table

1. Navigate to the View Results/View Heat Map view. 

2. In the Results table, click the triangle in the column header to open the 
dropdown list.

The dropdown list displays a list of the different sample types for that column.
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Analyzing Your Data
3. Select and clear the checkboxes to include or exclude the desired samples.

Note: When a filter is applied, the filtering is carried throughout the entire 
project.

You can also view your data as a heat map, a graphical representation of data that 
enables you to quickly identify the intensity readings and to find patterns in the data. 
For more information on heat maps, see the Bio-Plex Data Pro User Guide.

Step 8: The Perform Analysis/Create Charts View

When you select a parameter in the “Compare by” dropdown list, a list of sample 
types is displayed. You can include or exclude the sample types from the Filter list.

Select a column in the 
“Compare by” dropdown list

Then select and clear 
checkboxes to include and 
exclude samples
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Step 9: Analyze Your Data in Bio-Plex Data Pro Software 

1. Click Perform Analysis/Create Charts. 

2. From the “Compare by” dropdown list, choose the parameter you want to see 
on the x-axis on the charts in the Analyte Charts and Tables pane.

Select a column in the  
“Compare by” dropdown list
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Analyzing Your Data
3. If you have a control in your experiment, select this group from the Control 
dropdown list.

4. Review the results using the different display options.

TIP:  When you use the bar graph, you may select as many analytes for 
comparison as you like.

Analyze Your Data Using Other Tools

There will be instances when you want to perform an analysis that is not supported 
by Bio-Plex Data Pro, or when you want to verify the results using other software 
tools. There are two primary ways to do this:

 Statistical software packages — the Export to Statistics Package table is 
automatically generated in the Perform Analysis/Create Charts view. You 
can copy your table, plot, or graph to the clipboard and paste the data into 
the statistical software application. The Export to Statistics Package table 
is updated when you change the “Compare by” and Control choices.

 Microsoft Excel — you can perform additional calculations by copying the 
Group Statistics table in the Perform Analysis/Create Charts view to Excel. 
You can also produce custom tables in the Results table (View Results/
View Heat Map view) by using the filter and sort functions in the column 
headers.

Select a group in the  
Control dropdown list
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For More Information about Bio-Plex Data Pro Software

You can get more information about Bio-Plex Data Pro from the following sources:

 Bio-Plex Data Pro User Guide, which is available on your Bio-Plex Data Pro 
Software Installation CD as a PDF file. This guide is also available from the 
Help menu in the application. Click Help, then click View Online Help.

 Bio-Plex Data Pro updates, training resources, tutorials are available on the 
Bio-Rad Laboratories web site. From any view in the application, click 
Help, then click Go To Resources and Updates to download available 
resources.
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2 Bio-Plex Data Pro™ 
Software Overview
This chapter provides an overview of the Bio-Plex Data Pro software: the 
workspace, toolbars, menus, and commands that you use to view, edit, and analyze 
your experiment data.

The Workspace

The Bio-Plex Data Pro Home view displays buttons to create a new project or to 
open an existing project. You can also open a recent project by clicking the project 
name in the Recent Projects list. The left pane displays the project workflow, starting 
at the top with Manage Data Sets and ending with Perform Analysis/Create Charts. 
Once a project is open, clicking each button in the left pane takes you to the view 
where you complete the step.
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Toolbar Commands

Toolbar buttons give you quick access to basic commands. You can also access 
these commands from the menus.

Home

New Project

Open Project

Import Bio-Plex Results File

Undo

Redo

Select Sample Type for Analysis — opens a dialog 
box in which you select the sample types to use in 
your analysis. These sample types are the 
standards, controls, blanks, and unknowns 
imported from Bio-Plex Manager™ software. This 
selection is a global setting.
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The Workspace
Overflow Toolbar Commands

Clicking the triangle displays an overflow toolbar of hidden commands. Overflow 
toolbars are enabled whenever the screen size does not allow all toolbar commands 
to be displayed.

Clear All Analysis Filters

Manage Analytes — opens a dialog box that allows 
you to include or exclude analytes from view and 
change the order in which analytes are displayed in 
Bio-Plex Data Pro.

Reset Sample Lists to Default Sort

Merge samples run on different panels/assays

Undo Merge Samples
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File Menu Commands

The following commands can be accessed from the File menu:

 New Project — opens a dialog box in which you specify project details

 Open Project — opens a dialog box in which you can open an existing 
project and organize your projects

 Export Project — exports a project that can be shared with other users

 Import Project — imports a Bio-Plex Data Pro project

 Import Bio-Plex Results File — opens a dialog box, in which you can 
browse to a data set and import it

 Exit — closes Data Pro software

Edit Menu Commands

The following commands can be accessed from the Edit menu:

 Undo — removes the effect of an action you performed.

 Redo — restores the effect of an action you undid.

Overflow toolbar

Overflow toolbar
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Edit Menu Commands
 Cut — copies contents of selected cells to the clipboard and deletes 
contents of selected cells that are not read only.

 Copy — copies the contents of selected cells to the clipboard.

 Paste — pastes clipboard contents into the table. Read-only cells are 
skipped. When clipboard content is a single value, its content is copied to 
each selected cell in the table.

 Customize Sample Table — opens a dialog box in which you can select 
or clear columns or add new columns to the sample table.

 Customize Result Table — opens a dialog box in which you can hide or 
display columns, add new columns, and reorder columns.
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 Copy Table to Clipboard — copies the entire table to the clipboard, 
including the column titles.

 Copy Table to Clipboard Full Precision — copies the data with full 
precision to the clipboard.

 Copy Plot to Clipboard — copies selected scatter plot or box and whisker 
plot to the clipboard.

 Export Plot — exports plots or graphs to a Portable Network Graphics 
(.png), JPEG, bitmap, or TIFF format.

Keyboard Commands for Editing Tables

In addition to Edit menu commands, you can use the following commands to copy, 
paste, and delete data in tables. 

Data Menu Commands

The following commands can be accessed from the Data menu:

CTRL+A Select All selects the entire table in tables that allow multiple 
selections.

Copy Table to 
Clipboard

Right-click the table and select Copy Table to Clipboard on 
the context menu to copy the entire table to the clipboard, 
including the column titles.

CTRL+C Copies the contents of selected cells to the clipboard.

Delete Deletes the content of selected cells if they are not 
read-only.

CTRL+X Copies contents of selected cells to the clipboard and 
deletes content of selected cells that are not read-only.

CTRL+V Pastes clipboard contents into the table. Read-only cells are 
skipped. When clipboard content is a single value, its 
content is copied to each selected cell in the table.
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View Menu Commands
 Manage Analytes — opens a dialog box that allows you to include or 
exclude analytes from view and change the order in which analytes are 
displayed in Bio-Plex Data Pro.

 Select Sample Type for Analysis — opens a dialog box in which you 
select sample types to use in your analysis. These sample types are the 
standards, controls, blanks, and unknowns imported from Bio-Plex 
Manager.

 Clear All Analysis Filters — clears all filters in the project.

 Reset Sample Lists to Default Sort — clears all sort settings in the 
project.

 Merge samples run on different panels/assays — opens a dialog box 
that allows you to merge samples from different data sets (.rbx files) that 
share the same identity. Choose the column that contains the information 
you need to match samples. 

Use Merge Samples when you notice samples listed several times that you 
want analyzed as a single sample.

 Undo Merge Samples — restores the sample row settings.

View Menu Commands

From the View menu you can access the following:

 Imported data sets in the Data Set Table

 Individual sample data in the Sample Table
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 Results in the Results Table (Single Analyte), Multi Analyte Table, and Heat 
Map

 Data in Scatter Plot, Box and Whisker Plot, Bar Graph, Summary Table, 
Export to Statistics Software table, and Results by Sample table
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3 Adding Experimental 
Information
The Edit Samples/Add Columns view displays a tabular list (Sample table) of all 
unique samples in a project in the raw form imported from the RBX files. In this view, 
you add columns to the Sample table, which allows you to define your biological 
replicate groups and assign other important information such as demographic data, 
strain, or gender associated with each sample. You can add data from a 
spreadsheet to each cell, to one row or one column at a time, or all at once.

Editing the data adds descriptive information that enables you to make meaningful 
comparisons when you analyze the data. This descriptive information is a 
prerequisite for data visualization and statistical calculations. Annotation assists you 
in identifying data groupings.
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The Sample Table

The Sample table displays the following columns by default.

Sample ID — this field can be used to assign a unique ID to a sample and its 
replicates.

Data Set — one source data set; if the sample belongs to multiple data sets, the 
sample is listed multiple times.

Sample Type — Unknown, Control, Standard, Blank, or External Standard.

Description — displays information that was entered in the sample description in 
the originating Bio-Plex Manager™ software Results file. You can edit this field.

Well Locations — the well or wells on the plate where the experiment was run, for 
example, A1, A2 or C1, D1.

Sample Label — name of the sample, for example, S1–Sn, X1–Xn, C1–Cn, eS1–
eSn. Replicates identified in Bio-Plex Manager™ software are merged.
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About the Sample and Results Tables
Edit Samples/Add Columns Toolbar

The toolbar in the Edit Samples/Add Columns view displays additional icons.

The toolbar also displays a dropdown list of all the data sets in the project.

Left and right arrows facilitate scrolling through the list. This list enables you to view 
just the data set you want to edit. The choice of data set persists for the duration of 
the session.

For a description of the other toolbar icons, see Toolbar Commands on page 24.

About the Sample and Results Tables

The Sample and Results tables are synchronized, so changes you make to one table 
are immediately reflected in the other. For example:

 Filtering data from one table filters it from the other.

 Sorting data in one table sorts it in the same order in the other.

 Adding a column of data in one table adds it to the other. 

 Changing the order of the columns in one table changes the column order 
in the other.

Changes you make to either table persist — that is, these changes are saved if you 
switch to another view of the project, switch to a different project, or exit from the 
Bio-Plex Data Pro™ software program.

Customize Sample Table — opens a dialog box in which 
you can select columns that will be visible in the Sample 
table.

Add Column — opens a dialog box in which you can select 
a column to add or type a column heading.
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Adding a Column

In addition to the predefined columns, you can add up to ten custom columns to the 
Sample or Results tables. When a custom column is added to a table, you must 
specify its attributes.

A column that is added to the Sample table is also added to the Results table and 
the reverse is also true. Columns are added to the left of existing columns. You can 
reposition a custom column by clicking the column heading and dragging it to a new 
position in the table or by using the Customize Sample Table dialog box.

The column order you create in the Sample table also applies to the Results table; 
similarly, the column order you create in the Results table also applies to the Sample 
table. Note, however, that the Results table with multiple analytes has fixed 
columns.

To add a column to the Sample table

1. Click Add Column in the toolbar to open the dropdown list. 

2. Select a column from the list or select Other and type a name for the column in 
the Header box. You can select from the following predefined column headings:

 Time (numeric units only: select seconds, minutes, hours, days, or months)

 Dose (numeric)

 Concentration (numeric)
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Adding a Column
 Compound (text)

 Drug (text)

 The type of data that is valid for each column appears in parentheses.

Note: Column names within the Samples and Results tables must be 
unique. This applies to all columns — predefined columns and columns 
that have been added by users. If a name you enter in the Header box is 
already in use, you are prompted to choose another column name.

Hint: You may get a prompt to provide another name for the column and yet not 
see the column name in the table. This can occur if the column is hidden from 
view.

3. (Optional) Type a unit in the Unit field.

4. Click OK. The column is added to both the Sample and Results tables.
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4 Working with Projects
 A project is the container for your data. After you create your project, you import 
data set files that contain data from your experiments. There are two ways to import 
data sets: you can import existing data set files into Bio-Plex Data Pro™ software, 
or you can start from Bio-Plex Manager™ software and seamlessly import data into 
Bio-Plex Data Pro. You can create as many projects as you like.

Projects can be shared between users. You can export a project to share it with 
other Bio-Plex Data Pro users, and you can import projects exported by other users.
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Creating a Project

Follow the procedure for creating a new project and importing a data set.

To create a project

1. From the Home view, click New Project.

The New Project dialog box appears.

Note: You can also create a new project by selecting New Project from the 
File menu or clicking New Project in the toolbar.

2. Type a name for the project in the Name box.

3. Type the name of the project owner in the Owner box.

4. (Optional) Type the name of the team.

5. (Optional) Type the name of the supervisor.

6. (Optional) Type a description for the project (up to 255 characters).
38  |  Bio-Plex Data Pro Software User Guide



Creating a Project
7. Click OK. 

The Import Bio-Plex Results File dialog box appears.

Note: The name of the project appears in the Import Into list.

8. Click Browse and navigate to the data sets you want to import. 

9. Select the data sets you want to import and click Open.

10. In the Import Bio-Plex Results File dialog box, click Import.

The data sets are copied into the database. When the Status displays Done, the 
data sets have been successfully copied.

11. Click Close.

The project opens in the Manage Data Sets view and displays the Data Sets 
table.
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Data Sets Table

The Data Sets table displays the details for the data sets imported from RBX files at 
the plate level. It is most useful immediately after data import, when you can use it 
to verify that the imported data are what you want to analyze.

The following information is displayed for each data set:

Name — displays the name of the data set; by default this is the name of the 
imported Bio-Plex Results file (.rbx file).

User Name — displays the name associated with the data set as specified in the 
general information page of Bio-Plex Manager.

Acquisition Time — displays the date and time the data were collected on the Bio-
Plex instrument.

Description — displays the data file description entered in the Bio-Plex Manager 
RBX file.

Imported Date — displays the date the file was imported into the system.

Imported by — displays the name of the Windows user logged in when import 
occurred.
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Opening a Project
Opening a Project

You can open a project in the Home view by clicking on the project name in the 
Recent Projects list or by clicking Open Project.

To open a project

1. In the Home view, click Open Project.

2. In the Open Project dialog box, click on the project name.

If the project contains data, the project is opened in the Manage Data Sets 
view. It displays all the data sets contained in the project. See Importing Data 
Sets on page 46 for more information about data sets.
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If the project does not contain data, the Import Bio-Plex Results File dialog box 
appears. See Importing Data Sets on page 46 for information on importing data 
into your project.

Note: Bio-Plex Data Pro checks both the active and inactive projects to 
see if a project exists with the same name as the project being imported.

Selecting Samples

When you import Bio-Plex Manager data sets into Bio-Plex Data Pro, all of the 
samples in your experiment are imported. Typically, you will want to exclude some 
samples, for example Blank and Standard samples. Use “Select Sample Type for 
Analysis” in the toolbar to specify which samples to include. This is a global setting 
that applies to all views of the project in Bio-Plex Data Pro.

Note: By default, the Blank and Standard samples are excluded from the 
analysis.

To select the samples to be used in your analysis

1. Click “Select Sample Type for Analysis” in the toolbar.
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Exporting and Importing Projects
2. In the Filter Samples dialog box clear the checkboxes for the samples you want 
to exclude from your analysis.

3. Click OK.

Exporting and Importing Projects

You can share the data in your projects by exporting the project to a file. Another 
user can then import the project into Bio-Plex Data Pro on their computer.

Note: You export a project. Another user imports this project, edits the project, 
and then exports the project with the changes he or she made to it. You will be 
able to import this edited project into Bio-Plex Data Pro; however, you will not 
be able to merge their changes with your project.

Exporting Projects

To export a project

1. Open the project you want to export.

2. From the File menu, click Export Project.

3. In the Export Project dialog box, navigate to where you want to save the project 
file.

4. Click Save.

The file is saved with a .bpd extension.

Importing Projects

To import a project

1. From the File menu, click Import Project.

2. In the Select Project for Import dialog box, navigate to the project you want to 
import. Select the project, and click Open.

3. (Optional) In the Import Project dialog box, you can edit the properties of the 
project.

4. Click OK.
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5. From the File menu, click Open Project to see the imported project in the list of 
active projects.

Editing a Project

You can edit project attributes in the Edit project dialog box.

To edit a project

1. Click Open Project.

The Open Project dialog box appears, displaying a list of projects.

2. Right-click in the row of the project you want to edit, and click Edit Project.

TIP:  Do not click the project name; this opens the project.
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Organizing Your Projects
The Edit Project dialog box appears.

3. Edit the project settings and click OK. 

Organizing Your Projects

Over the course of time, you will create multiple projects, and you may not be 
working with all of them at the same time. You can organize your projects by 
removing projects that you are not currently working on from the list of active 
projects and moving them to the Inactive Projects list. You can perform any of the 
commands on an inactive project that you perform on an active project; you can 
open and edit the project, view the data, and perform statistical analysis on the 
data, and so on. You can return inactive projects to the Active Projects list at any 
time.

To move a project to the Inactive Projects list

 From the Active Projects tab in the Open Projects dialog box, select the project 
you want to move to the Inactive Projects list and click Deactivate.

To return a project to the Active Projects list

 From the Inactive Projects tab in the Open Projects dialog box, select the 
project you want to move to the Active Projects list, and click Activate.
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Importing Data Sets

Data are imported into projects from the Import Bio-Plex Results File dialog box. 
You can select an existing project or you can create a new project into which the 
files are imported.

You control the data that are imported in one of the following ways:

 Add data files using the Import Bio-Plex Results File command.

 From Bio-Plex Manager, import your results directly into Bio-Plex Data Pro.

All files that appear in the Data Set Files list are imported into the selected project. 
You can combine data from multiple experiments into a project. You can import up 
to ten data sets (RBX files) into a single Bio-Plex Data Pro project. Each RBX file 
represents one data set. You can import data set files into multiple projects by 
selecting another project.

The procedure for importing data in Bio-Plex Data Pro differs slightly from importing 
through Bio-Plex Manager. See Importing Data into Bio-Plex Data Pro Software on 
page 46 and Importing Data Directly from Bio-Plex Manager Software on page 48 
for more information.

Importing Data into Bio-Plex Data Pro Software

The following procedure describes how to import data into Bio-Plex Data Pro.

To import data sets into a project

1. From Bio-Plex Data Pro, click Import Bio-Plex Results File in the 
toolbar.

The Import Bio-Plex Results File dialog box appears.

2. Select the desired project from the Import Into dropdown list or create a project 
by clicking New Project.

3. Click Browse to navigate to and select the data sets you want to import.

4. Click Open.
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Importing Data Sets
The Data File field displays the file name, including the path to the file. The 
Status displays as Ready.

5. Click Import. 

The system imports all data files in the list. Each file displays a status as it is 
imported:

Done — the data set was successfully imported.

Exists — if you try to import a data set that was previously imported into the 
project, Bio-Plex Data Pro does not reimport the data. It displays the status 
Exists to indicate the data have already been imported into the project.

Ext. Standards — the data were successfully imported. The unknown values 
were calculated using an external standard curve. The standards in the plots 
are imported.
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Renamed — the data were successfully imported. The name of the file being 
imported is the same as a file previously imported into the project, but the data 
are different. To distinguish between the two data sets, the file name of the data 
being imported is appended with a number, for example 001 is appended at the 
end of the file name Bio-Plex Phosphoprotein 11-Plex 001.

Note: If the data being imported are identical to data previously imported 
but they are exported from a different version of Bio-Plex Manager, 
Bio-Plex Data Pro imports the data and displays the Renamed status.

6. You can click Browse and import additional data sets or click Close if you are 
done importing data.

Importing Data Directly from Bio-Plex Manager 
Software

The Export Results to Bio-Plex Data Pro feature in Bio-Plex Manager allows you to 
import data directly into Bio-Plex Data Pro. You initiate the data export from 
Bio-Plex Manager. Then the Import Bio-Plex Results File dialog box in Bio-Plex Data 
Pro displays automatically. If the Bio-Plex Data Pro program is not already running, 
it launches automatically.
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Editing a Data Set
The Data File field displays the file name and indicates the source as Bio-Plex 
Manager. You may import this data set just as you would any RBX file. You can add 
more data sets to this list by using the Browse button. You may also return to 
Bio-Plex Manager to export another data set.

For more information on this feature, see the Bio-Plex Manager Software 6.1 User 
Guide.

Editing a Data Set

You can edit the name and description of a data set.

To edit a data set

1. Open the project whose properties you want to edit.

2. In the Data Sets table, right-click the data set you want to edit, then click Edit 
Data Set in the context menu. 

The Edit Dataset dialog box appears.

3. Edit the name and description and click OK.
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Deleting a Data Set

The following procedure describes how to delete a data set from your project.

To delete a data set

1. In the Data Sets table, select the data sets you want to delete.

2. Right-click and select Delete Data Set in the context menu.

A message asks you to confirm that you want to delete the data set.

3. Click Yes. 

The data sets are deleted from the project.
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5 Viewing the Data
There are several different ways you can view your results in Bio-Plex Data Pro™ 
software. You can look at the results for one analyte at a time. You can view all the 
analytes at once and compare the results. You can view the results graphically in a 
heat map. In addition, you can merge multiple rows of data for the same sample to 
simplify your view of the data.

Viewing Results

In the View Results/View Heat Map view, the Results table lists data by individual 
samples from every RBX file imported into the project. It presents a view of the 
aggregates of all the results across plates.
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Use this table to review the results of the experiment you imported. You can specify 
how you want to view the results by filtering or by adding custom columns. Columns 
and the order you select in the Results table persist until you change them.

You can also select different analytes and switch from the table to a heat map view. 
Heat maps help you quickly identify the intensity readings for an analyte. 

View Results/View Heat Map Toolbar

In the View Results/View Heat Map view, the following buttons are added to the 
toolbar. Each option affects the data shown in the Results table.

Results Table (Single Analyte)

Heat Map Result View

Multi Analyte Table

 
Analyte dropdown list with left and right arrows

Fluorescent intensity of the selected analyte

Observed concentration of the selected analyte

Observed concentration that falls within the “usable” range of the 
standard curve

The normalized ratio, fold expression, or gene expression value 
calculated in Bio-Plex Manager™ software

Coefficient of variation

Standard deviation over the mean of a group of replicates

Customize Result Table

Add Column
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View Results/View Heat Map Toolbar
The Results table displays the following columns by default. You can add columns 
by clicking Add Column in the toolbar.

Sample ID — you can edit this field.

Data Set — one source data set; if the sample belongs to multiple data sets, the 
sample is listed multiple times.

Sample Type — Unknown, Control, Standard, or Blank.

Description — displays information that was entered in the sample description in 
the originating Bio-Plex Manager results file. You can edit this field.

Well Locations — the well on the plate where the experiment was run; for example, 
A1, B1 or C1, C2, C3).

Sample Label — name of the sample; for example, S1–Sn, X1–Xn, and  
C1–Cn. Samples with the same data set and sample label are merged.

Obs Conc — observed concentration (custom column).

Conc %CV — coefficient of variation of the concentration (custom column).

Viewing Results for All Analytes

You can view the results for all analytes by clicking Multi Analyte Table in the toolbar. 
Columns are displayed with headings and subheadings. You can sort data in the 
columns, but you cannot change the order of the columns. (See Sorting Data on 
page 65.) You can customize the table by showing and hiding columns. (See Sorting 
Data on page 65.) Filters applied elsewhere in the application are preserved here, 
but you cannot apply a filter in the Multi Analyte table.

This table is useful for copying data to spreadsheet software for further analysis.
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Merging Data
Merging Data

Samples may be run several times for one of the following reasons:

 Dilution requirements may be very different for different assays.

 Bead regions for the assays may overlap.

 Assays from different kits cannot be mixed together for other reasons.

The outcome of this is that results for a particular sample appear in several data 
sets. When the data files are imported, the sample is listed multiple times in the 
Sample and Results tables. (The tables in the Perform Analysis/Create Charts view 
are generally unaffected depending on your experimental setup.) The “Merge 
samples run on different panels/assays” command allows you to combine the rows 
of data so that each sample appears only once in the table. Merging data reduces 
the complexity of the data.

Data can be merged based on a matching Sample ID, Description, or Sample Label, 
or a combination of these fields. You can also merge the data using custom fields. 
Another use for merged data is to average the data in the grouped samples.

You can always unmerge merged data. Merging data does not change the original 
data.
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To merge results data

1. In the Results table, choose “Merge samples run on different panels/assays” in 
the toolbar.

2. In the Merge Samples Dialog dialog box, select the columns to match and 
merge samples.

Records with matching names in the selected column are merged 
appropriately. When data are merged, a column is added to the left side of the 
table (Merge column), and this column is used to sort the table in ascending 
order.

To unmerge results data

 Select Undo Merge Samples in the toolbar. In the Results table, all merged data 
are separated.
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Viewing Merged Data in the Results Table

In the Results table, the Merge column displays the number of rows that have been 
merged for each group.
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The lock in the first column indicates that the data in these rows cannot be edited.

In a merged table, Observed Concentration (Obs Conc) and Concentration of the 
coefficient of variation (Conc %CV) columns report average values for merged rows.

The multiple analyte view shows all the analytes and observed concentration 
merged values for each analyte.

Viewing Merged Data in the Sample Table

Merged data in the Sample table are displayed as individual rows. The rows are 
sorted so that all merged rows are grouped next to each other. You can edit the 
merged data in the Sample table; for instance, if you mislabeled a sample. The data 
will be remerged dynamically based on your edits.

Merge Column

Locked Rows
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Heat Map Result View
When you import data into a merged project, the new data are merged 
automatically.

Heat Map Result View

A heat map is a graphical representation of data that enables you to quickly identify 
the intensity readings and to find patterns in the data. Each column in the heat map 
corresponds to an analyte, each row to a sample, and each cell to a data point. The 
cells are color coded according to their median or midpoint compared to other 
samples for that analyte.
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You can copy heat maps and tables to the clipboard and paste them into the 
application of your choice. (See Copying Plots and Graphs to the Clipboard on 
page 94.)

To switch from table to heat map view

 Click Heat Map Result View in the toolbar. The Results table data appear as a 
heat map.
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Heat Map Result View
Hovering over a cell in the heat map displays a description of that cell’s contents.

Commands to the left of the heat map control the order of the samples and the 
labels used in the heat map. The Chart Options menu allows you to change the 
manner in which the intensities are calculated and displayed.

Chart Options Menu Commands

From the Chart Options menu, you can access the following commands:

Frame Cells — a toggle that turns on or off contrasting lines framing each cell.

Sample Label Field — opens a dropdown list of the types of data that can appear 
as the sample label to the immediate left of the heat map.

Intensity Type — opens a dropdown list of the types of data that can be displayed.

Data Transform — opens a dropdown list of the ways the data can be calculated. 

Color Gradient — lists colors and color combinations you can select to change the 
appearance of the heat map.
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Toolbar Commands

Intensity Type, Color Gradient, and Frame Cells controls also appear in the toolbar. 
In addition, Width and Height controls make it easy to resize the heat map.

Heat Map Settings

The pane to the left of the heat map controls the labeling and sorting of the samples. 

Labeling the Heat Map

The Sample Label Field dropdown list displays the columns in the Results table. You 
can label the heat map with the values of one of these columns.

Use the controls 
to label the heat map

and to sort samples
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To specify a sample label in the heat map

 Click Sample Label Field dropdown list and select one of the choices in the list.

If <none> is selected, no sample label appears next to the heat map.

Grouping Data in the Heat Map

You can specify how data in the heat map are grouped. You can group your data by 
any column in the Results table. 

Note: The “Group by” dropdown list includes all visible predefined and custom 
columns in the Results table. Hidden columns do not appear in the list.

Using the controls to the left of the heat map, you can apply up to three levels of 
sorting to the heat map data. The primary sort is set using the “Group by” control. 
The second and third-level sorts are applied using the “Then by” controls. Each 
subsequent sort is done within the constraints of the previous sorts. For each sort 
level, you can also select whether the data appear in ascending or descending 
order.

To sort the heat map data

1. Click “Group by” and select a column from the list.

2. Select Ascending or Descending.

3. If you want the sort option to appear in the sample label, click the “Show in 
sample label” checkbox.

4. If you want to apply another level of sorting, click “Then by” and select another 
column from the list. Follow the procedure in Step 2 and Step 3.
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Adding a Column

You can add columns to the Results and Sample tables. See Adding a Column on 
page 34.
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6 Customizing the View of 
Your Data
After data sets are imported into Bio-Plex Data Pro™ software, you can sort the 
data on any number of columns and hide columns that you do not need.

Sorting Data

You can sort any number and combination of columns of data in ascending or 
descending order. You apply a sort to the first column, and the rows of data are 
resorted based on the order you select. If you then apply a sort on a second column, 
the first sort persists, and the second sort is applied to the sorted data. You can 
always return your data to its original unsorted state.

All tables in the application can be sorted by clicking on the column header. In 
addition, you can sort the Sample and Results tables by clicking on the triangle in 
the column header. 

For more information on sorting, see the following:

 Defining a Sort in the Sample or Results Tables on page 66

 Basic Sorting in Bio-Plex Data Pro Software on page 70
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Defining a Sort in the Sample or Results Tables

Sorted data in the Sample or Results tables persist between sessions.

To define a sort in the Sample or Results tables

1. Click the button in the column header to display a dropdown list.

Note: The icon that appears on the button varies depending on whether the 
data are sorted, filtered, or neither. See Sorting and Filtering Icons on page 69 
for a description of the icons.
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Sorting Data
2. In the Sorting section, select Ascending or Descending to sort the data in the 
column.

After a sort is applied to a column, an arrow appears in the column either pointed up 
(ascending sort) or pointed down (descending sort). A black arrow indicates the first 
sort, also known as the primary sort. All subsequent sorts are indicated with a grey 
arrow.

TIP:  You can sort a single column by clicking the column header. Clicking 
multiple times cycles through ascending sort, descending sort, and no sort. 
When you click on a column header, any existing sort settings on the table are 
cleared.

You can clear sorting on a single data column, or you can clear sorting on all table 
columns at one time.
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Clearing Data Sorting

To clear sorting on one column

 To clear sorting on the column, click the button in the column header to display 
the dropdown list, and select None.

When you clear sorting on one column, the sorting on any other column is 
retained. The data will resort based on the remaining sort settings.
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To clear sorting on all columns

 To clear sorting on all columns in the table, click Reset to Default Sort in the 
dropdown list for any column or click the Reset to Default Sort button in the 
toolbar.

Sorting and Filtering Icons

For the Sample and Results tables, a button on each column displays a triangle by 
default. The icons on the button change depending on the combination of sorting 
and filtering applied on the column.

Column is not sorted or filtered. This is the default.

Column is filtered only.

Column is sorted only. The arrow pointing up indicates 
ascending order. An arrow pointing down indicates 
descending order.

Column is both sorted and filtered. In this example, 
the down-pointing arrow indicates descending order.
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Basic Sorting in Bio-Plex Data Pro Software

This section describes how to sort Bio-Plex Data Pro data if you are not using the 
sort tool available in the Sample and Results tables. Sorting that is done without the 
sort tool — that is, basic sorting — does not persist between sessions. The data 
return to their pre-sorted order.

For information on sorting in the Sample or Results table, see Defining a Sort in the 
Sample or Results Tables on page 66.

To sort data

 Click the column header once to sort the data in ascending order. A 
triangle appears in the column header indicating an ascending sort is 
applied on the data.

 Click the column header a second time to sort the data in descending 
order. The triangle in the column heading is now inverted, indicating a 
descending sort is applied on the data.

 Click the column header a third time to return the data to its unsorted state. 
The triangle disappears, indicating the data are unsorted.

TIP:  To sort on multiple columns, hold the SHIFT key down and click on 
the column header. You can sort on as many columns as you like.

Hiding a Column

Any column can be hidden from view. Columns you hide in the Sample table are 
hidden in the Results table and the reverse is also true. Hiding columns enables you 
to exclude data from being exported. Only data visible in the table are exported.

To hide a column in the Sample table

1. In the Edit Samples/Add Columns view, click the Customize Sample Table in 
the toolbar.

2. In the Customize Sample Table dialog box, clear the Visible checkbox for each 
column you do not want to display.

3. Click OK.
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To hide a column in the Results table

1. In the View Results/View Heat Map view, click Customize Result Table in the 
toolbar.

2. In the Customize Result Table dialog box, clear the Visible checkbox for each 
column you do not want to display.

3. Click OK.
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7 Defining the Scope for 
Your Analysis
Data can be included or excluded from the project dynamically. This is referred to as 
filtering. Use the filter tools to choose which samples to include in your analysis. 
These filters are available in most views throughout the software and apply across 
the entire project. For example, filter settings you apply to the Sample table are 
reflected in the Results table and Perform Analysis/Create Charts view.

Note: To restore your view to include all samples, click the Clear All Analysis 
Filters button.

Filtering Data in the Sample and Results Tables

Contents of each column, including custom columns, can be filtered using the 
dropdown list in its column heading. By default, all rows are included.

Note: Filters cannot be applied to the Multi Analyte table in the View Results/
View Heat Map view.
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To filter data

1. Click the triangle in the column header to open the dropdown menu.

In the Filter section, there is a list of the different sample types for that column.

2. Select the checkboxes of the samples you want to include, and clear the 
checkboxes of the samples you want to exclude.

Filtering Data in the Perform Analysis/Create Charts View

The filter tool allows you to filter your data in the same way that you filter your data 
in the Results tables.

To filter data in the Perform Analysis/Create Charts view

1. Click “Filter by” and choose the column you want to use to filter your data.

The list of samples is displayed in the Filter section.
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Filtering Data in the Perform Analysis/Create Charts View
2. Select the checkboxes of the samples you want to include, and clear the 
checkboxes of the samples you want to exclude.
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Restoring Filtered Data

You can restore data that have been hidden from view by clearing the filters.

To clear filtering

 To clear filtering on a column, click the button in the column header to 
display the dropdown list and select Select All.

 To clear all filters on all columns in the table, click Clear All Analysis Filters. 
There are two places where you can do this. You will find it in the dropdown 
list for any column or in the toolbar.

Clear All Analysis
Filters
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8 Analyzing and Plotting 
Your Results
In the Perform Analysis/Create Charts view, you can view the graphs and tables that 
present your results in biologically relevant groupings.

Proper annotation of your samples is a prerequisite for using this view. At a 
minimum, the “Compare by” dropdown list should include column headings that 
contain the biological replicate groups you want to compare and display on the x-
axis of your graphs. Subpopulations of samples can be analyzed by excluding 
samples from the view using the “Filter by” dropdown list. Changing the column in 
the “Compare by” or “Filter by” dropdown lists dynamically updates all views. 

The column selected in the “Control by” dropdown list is the biological replicate 
group that represents the control for your experiment. By choosing a control group, 
several calculations are automatically generated, including a P-value calculation 
(either a t-test or Mann-Whitney, depending on which test is selected) and a log-
scale fold change between the control and each of the experimental groups. 

Statistical analysis is useful for identifying analytes that display differences between 
the groups under observation. Selecting the Perform Analysis/Create Charts view 
displays a table of statistical information for all analytes. This view enables 
visualization and discovery of statistically significant differences (P-value and fold 
change) among sample groups within each analyte in the project.
Bio-Plex Data Pro Software User Guide  |  77



8  |  Analyzing and Plotting Your Results
Analysis Workflow

The statistical analysis workflow comprises the following actions:

 Choose the variable for comparison. In order to do this, you must first 
annotate the data.

 (Optional) Choose the biological replicate group that represents a control 
for your experiment (if one exists) to do pair-wise comparisons between the 
control and all other groups.

 Select the statistical test to apply to the data.

 Use the filter to exclude data or refine group selection. If the desired 
samples are not available in any of the Filter options, add a new custom 
column in the Sample table or edit the annotation of an existing column 
(Filter).

 For each analyte, visually inspect the differences between the groups.

Analysis Workspace

Analysis configuration

Analyte table

Analyte charts 

and tables
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Analysis Workspace
There are three panes in the workspace:

 Analysis configuration — the series of controls on the left most side of this 
view that define the specifics of your desired analysis.

 Analyte table — table at the top of this view. It shows all analytes in the 
selected samples with descriptive statistics for each analyte.

 Analyte charts and tables — charts and tables that provide the results to 
the analysis you have configured using the controls in the analysis 
configuration pane.

Analysis Configuration Pane

The area on the left of the Perform Analysis/Create Tables view is called the analysis 
configuration pane. It has the following controls to filter your data, indicate how data 
are compared, and specify which statistical test to apply for analysis.

Compare by — specifies the variable used to group the data for presentation in the 
charts and to apply statistical tests. The list displays the columns in the Results 
table.

Control — specifies the control group for your analysis. The list displays the groups 
for the variable selected in the “Compare by” dropdown list.

Statistical Test – specifies the statistical test applied.

 If the data are normally distributed, choose t-test/one-way ANOVA.

 If the data are not normally distributed or you are unsure how the data are 
distributed, choose Mann Whitney/Kruskall Wallis. This is the default.

Filter by — includes or excludes groups from your analysis. By default, it displays 
the same column heading selected in the Compare field. You can change this 
setting.

Clear All Analysis Filters — selects and includes all items that were cleared with 
any filter setting.

Note: This feature removes any filters that were set in any table in the product. 
Any filters you set in any of the other views will be cleared.
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Select All — selects all items in the list, therefore including them in the analysis.

Clear All — clears all items in the list, therefore excluding them from the analysis.

Analyte Table

The analyte table is the table at the top of this view. It contains a list of all analytes in 
the selected samples. Each row in the table contains the analyte name and 
descriptive statistics for the population of samples for this analyte.

Analyte Table Toolbar Commands

In the main toolbar you can select one of the following measurements for the analyte 
table. If all toolbar commands are not visible, click the triangle on the right side of 
the toolbar to view hidden commands.

Fluorescent intensity (FI) — a relative measurement of fluorescent intensity based 
on the median, a robust statistical measure.

Observed concentration — observed concentration of the analyte, calculated from 
its fluorescent intensity and the standard curve.

Observed concentration within range — observed concentration that falls within 
the range of standard concentrations, given a specified recovery range.

Ratio — normalized ratio, fold expression, or gene expression value calculated in 
Bio-Plex Manager™ software.
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Interpreting P-Value Statistics

Bio-Plex Data Pro™ software automatically calculates P-values. You can quickly 
sort the analytes by their P-values and examine the analytes with the lowest P-
values in order to visually see the differences between the sample groups. Bio-Plex 
Data Pro uses P-values to discriminate between sample groups. 

The smaller the P-value, the greater the probability that two or more groups of 
samples have significantly different analyte measurements. Typically, a  
P-value of less than 0.05 (5%) is considered significant. Note that when a project 
contains many analytes, some of them may have a low P-value by chance, even if 
the samples from different groups do not truly differ. Therefore, a low P-value is not 
itself an indicator of a good separation between sample groups. Analytes with low 
P-values may have a large overlap of concentrations between the sample groups. 
However, a large P-value is generally an indicator that significant differences do not 
exist.

Statistical tests require that two or more groups be identified, and they require that 
each group has more than one sample. If the Statistical Test options are disabled, 
then your groups do not meet these requirements. Select a different choice from the 
“Compare by” dropdown list or edit sample attributes to identify more than one 
group with the required minimum number of samples.

If samples are grouped by the “Compare by” column, the P-value column displays 
the P-value and the P-value Method column displays the method used to calculate 
the P-value. 
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Bio-Plex Data Pro uses different algorithms to calculate the P-values depending on 
the number of sample groups per analyte and the user’s preference for one test or 
another. All P-values are two-tailed probabilities. Bio-Plex Data Pro does not make 
any assumptions about the direction of difference between two or more groups. 

The following describes which statistical method is used to calculate the  
P-value. For data in a normal distribution, select t-test/One-Way ANOVA. The 
following logic is used to determine which test to apply:

 If there are two groups, a t-test is applied.

 If there are three or more groups, then the One-Way ANOVA test is applied.

For data that are not in a normal distribution, or if you are uncertain, select Mann-
Whitney/Kruskal-Wallis. The following logic is used to determine which test to apply:

 If there are two groups, the Mann-Whitney test is applied.

 If there are three or more groups, then the Kruskall-Wallis test is applied.

Bio-Plex Data Pro does not assume that data are in a normal distribution and uses 
the Mann-Whitney or Kruskal-Wallis test by default.

Understanding Fold Change Calculation

Fold change is calculated for each analyte. Samples are grouped by the field 
specified in the “Compare by” list. The mean is calculated for each of the groups. 
The fold change is calculated by dividing the highest mean value by the lowest 
mean value, then calculating the base 2 logarithm of the result.

Note: The values used in statistical calculations and plots depend on the 
measure type (FI, Obs Conc [observed concentration], In Range [concentration 
in range], or Ratio) selected in the main toolbar. All statistics — including P-
values, fold change values, and descriptive statistics — incorporate input only 
from valid sample values. If a sample value is out of range or below range, it is 
not included.
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Analyte Charts and Tables

The analyte charts and tables pane displays the following detailed information about 
the analyte selected in the analyte table. (These views can be accessed from the 
toolbar in the analyte charts and tables pane.)

The following are additional options available on the toolbar:

 Analytes — dropdown list of analytes in the data set.

 Fill — toggle between displaying the dots in the scatter plot as outlines or 
filled in.

 Point Size — changes the size of the dots in the scatter plot.

 Auto — when selected, controls the band width and margin of the scatter 
plot, bar and whisker plot, and bar graph.

Scatter Plot — displays the data for the selected analyte as a 
scatter plot. The x-axis in this plot does not represent a value. 
Dots are distributed in each group to facilitate visualization of 
each sample.

Box and Whisker Plot — displays the data for the selected 
analyte as a box and whisker plot.

Bar Graph — displays the data for the selected analytes as a bar 
graph with standard error bars.

Summary Table — displays descriptive statistics for each sample 
group in a separate row.

Results by Sample — displays the data used to create the plots 
and other tables along with descriptive data for the samples of the 
selected analyte.

Export to Statistics Software — displays the data grouped as 
defined in the configuration pane in a format that is convenient for 
export to statistical software. Each column displays the data for 
one group.
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 Band Width — when Auto is not selected, it controls how close the dots 
are to one another in the scatter plot. For the bar and whisker plot and bar 
graph, it controls the width of the bands.

 Margin — when Auto is not selected, it controls the distance between the 
bands in the bar and whisker plot and in the bar graph. In the scatter plot, it 
controls the distance between the sets of dots.

 Legend — when selected, a legend appears identifying the analytes in the 
bar graph.

Comparing Multiple Analytes

As you review the results on the Perform Analysis/Create Charts page, you can 
refine your view of your data by including multiple analytes in your analysis. Doing 
so makes it easier to find analytes that have different expressions across different 
groups. For example, you can compare one drug to another to look for a different 
expression between the drugs. You can view the results for more than one analyte.

The following analyte charts and tables support the viewing of multiple analytes: 
scatter plot, box and whisker plot, bar graph, and summary table.

To select multiple analytes, do one of the following

 Select one or more analytes from the analyte table.

Hold the CTRL key down and click in the Legend column to select multiple 
analytes from the table.

 In the analytes charts and tables pane, click Analytes to display a list of the 
analytes.
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Click the checkboxes to select the analytes you want to include.

Each selected analyte corresponds to a color. The colors in the Legend column of 
the analyte table match the colors of the plotted data in the analytes and charts 
pane. A legend is also displayed in the analytes and charts pane identifying the 
analytes. 

TIP:  You can hide the legend in the analytes and charts pane by clearing the 
Legend checkbox in the toolbar.

Filtering Analytes

As you review your results, you may decide certain analytes are not important for 
your analysis and you want to remove them from view. Removing an analyte from 
view is a global change and removes it from all views in the software. It is removed 
from the heat map and multi analyte table in the View Results/View Heat Map view, 
and from the charts and tables in the Perform Analysis/Create Charts view.
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To filter analytes

1. Click Manage Analytes in the toolbar to display the Manage Analytes dialog 
box.

By default, all analytes are visible as indicated by a check mark in the Visible 
column.

2. Click the checkbox in the Visible column to make an analyte visible.

3. Clear the checkbox in the Visible column to hide an analyte.

Note: Use the Apply button to see the changes in the Heat Map view and 
the Perform Analysis/Create Charts view.

4. Click OK.

Changing the Analyte Order

You can change the order in which analytes are displayed in the software. The same 
ordering of the analytes is applied across all views in the software; for example, the 
heat map, multi analyte table, and the charts and tables in the Perform Analysis/
Create Charts view.
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To change the order of the analytes

1. Click Manage Analytes in the toolbar to display the Manage Analytes dialog 
box.

2. Click the name of the analyte, then click the Up or Down button to move the 
analyte where you want it to appear.

TIP:  Be careful not to clear the checkbox when you select the analyte. 
Clearing the checkbox removes the analyte from view.

3. Click OK.

Scatter Plot and Box and Whisker Plot

The scatter plot and box and whisker plot display each group of samples as a 
category (band) along the horizontal axis. The scatter plot displays each sample as 
a point. Points within the same group are artificially spread out along the horizontal 
axis in order to minimize overlapping samples.
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A box and whisker plot is a quick way of graphically examining the distribution of 
points in each group. This plot is particularly useful for comparing distributions 
between several groups or sets of data.

The box and whisker plot displays a box from the first quartile to the third quartile. 
The bottom and top horizontal bars are the minimum and maximum sample values, 
respectively. The horizontal bar within the box represents the median sample value.

Multiple analytes can be compared in the scatter plot and the box and whisker plot. 
Each analyte corresponds to a color identified by a legend in the analytes and 
charts pane.
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When the Auto checkbox is selected, the plot displays all groups inside the view 
port and maximizes the use of the view port. When Auto is not selected, the Band 
Width (the width of the individual sample categories) and the Margin (the width 
between sample categories) can be adjusted manually.

Hovering over either plot displays detailed information about the object under the 
cursor.

Note: Plots display only samples with valid values.

Bar Graph

When you hover over the bar, an annotation appears with information about the 
analyte, including the mean value for the analyte, the P-value, the fold change, and 
the statistical method used.

On each bar, an error bar plots one standard error from the mean.
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Summary Table

The Summary Table displays descriptive statistics for each sample group. Each 
group is displayed as a row in the table. You can display the statistics for one or 
more analytes.

If you select a Control group, you will see the following statistics:

 P-Value —the P-value is the result of comparing the selected group with 
the control.

 Fold Change — the fold change is the base 2 logarithm of the ratio 
between the control group and group being compared. The minus sign 
indicates the down regulation of the group compared to the control. No 
sign indicates the up regulation of the group compared to the control.

For example, if the mean of the control group is 1 and the mean of the group 
being compared is 1, then the fold change is 0. If the mean of the group being 
compared is 2, then the fold change is 1. The following table shows the 
calculated fold change for different control groups and compare groups.

Mean Value of 
Control Group

Mean Value of 
Compare Group

Fold Change

1 1 0

1 2 1

1 4 2

2 1 -1

4 1 -2
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Export to Statistics Software

Use the Export to Statistics Software table to export your data to other software 
applications. For more information on this feature, see Copying Data to Third-Party 
Software on page 95.

Results by Sample

This table displays all the samples for the current analyte in rows. If a “Compare by” 
column is selected, the table includes this column to display the sample annotation 
for the group. In addition, this table includes the sample value for the currently 
selected measure type.
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9 Exporting Data and Plots
Data in Bio-Plex Data Pro™ software tables, plots, and graphs can be exported to 
the Microsoft Windows clipboard and copied into other software applications where 
you can analyze the data or edit the plots or graphs.

Copying Data in Tables

Copying a Data Row

When you copy a data set row to another application, only the selected rows are 
copied. The column heading is not copied.

To copy a row from the data set table

1. Select the rows you want to copy.

2. Right-click and click Copy in the context menu.

3. Right-click and click Paste in the application of your choice.

Copying the Data Set Table

You can copy the data set table to the clipboard and paste it into another 
application. Doing so copies the entire table, including the column headings.

To copy the data set table to the clipboard

1. In the data set table, right-click to open the context menu, and then click Copy 
Table to Clipboard.

2. Paste the table into the application of your choice.
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Viewing Data Values with Full Precision

Values in the data tables are rounded off. You can see the data values with full 
precision by copying the data to another application; for example, Microsoft Excel 
or Notepad. This is useful for verifying the software’s calculations.

To view the data with full precision

1. In the data set table, right-click to open the context menu, and then click Copy 
Table to Clipboard Full Precision.

2. Paste the table into the application of your choice.

Note: Check to see that the application is displaying the values with the level 
of precision you desire. For example, the default in Microsoft Excel is to display 
two decimal places. Use Format > Cells to change the level of precision.

Copying Plots and Graphs to the Clipboard

You can copy a plot or graph to the clipboard and paste it into an application.

To copy a plot or graph

1. In the plot or graph, right-click to open the context menu, and then click Copy 
Plot to Clipboard. 

2. Paste the table into the application of your choice.

Exporting Plots and Graphs at High Resolution

Plots and graphs can also be exported as Portable Network Graphics (.png), JPEG, 
bitmap, or TIFF files. These exported files are of higher quality than the ones 
produced using the copy and paste tools.

To export a plot or graph

1. In the plot or graph, right-click to open the context menu, and then click Export 
Plot.

2. In the Export Plot dialog box, enter the name of the file.
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3. Select the type of file in which you want to save the plot or graph.

4. Click Save.

Copying Data to Third-Party Software

The Export to Statistics Software table displays each group as a column and 
includes only the sample values. Unlike the Results by Sample table, it includes only 
samples with valid values. This table makes it possible to copy data to third-party 
software applications that support this format for sample groups.
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A Error Messages
As you view your results in the Perform Analysis/Create Charts view using different 
measurements, you may see errors. The following table describes the conditions in 
Bio-Plex Manager™ software that may cause the error.

Measurement Bio-Plex Data Pro™  
Error Message

Error Condition

FI Acquisition Error No data present or not runa

Not Run No Bio-Plex Manager data for that analyte

Obs Conc Acquisition Error No data present or not run 

Cannot Calculate No data present or not run for other 
reasons

Not Run No Bio-Plex Manager data for that analyte

OOR> OOR>

OOR< OOR<

Conc in 
Range

Acquisition Error No data present or not run 

Cannot Calculate No data present or not run for other 
reasons

Not Run No Bio-Plex Manager data for that analyte

OOR> OOR>

OOR< OOR<

Norm Ratio Acquisition Error No data present or not run 

Not Run No Bio-Plex Manager data for that analyte

Ratio Acquisition Error No data present or not run 

Not Run No Bio-Plex Manager data for that analyte

a. Not run means the sample is not run for any analytes and any replicates. All 
measurements are error not set.
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B Backing Up the Database
It is a best practice to back up the database frequently and keep the backup copies 
in a safe location. A USB or network hard drive is a good backup solution. Keep in 
mind that it can take several minutes to back up a large database. 

Follow the procedure for your operating system.

Backing up the Database on Windows 7

To back up the database

1. Exit Bio-Plex Data Pro™ software.

2. Navigate to C:\ProgramData\Bio-Rad\Bio-Plex Data Pro.

Note: If you do not see the ProgramData directory, the directory may be 
hidden and you must show the hidden files. See Showing Hidden Files on 
page 100.

3. Copy the database file, DataPro_104.db3, to a backup location.

Note: If you upgrade from Bio-Plex Data Pro 1.0 to 1.1, you will see the 
database file for Bio-Plex Data Pro 1.0, DataPro_102.db3. We recommend 
that you back up this file as well.

Backing up the Database on Windows XP

To back up the database

1. Exit Bio-Plex Data Pro software.
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2. Navigate to the following location: 
C:\Documents and Settings\All Users\Application Data\Bio-Rad\Bio-Plex Data 
Pro.

Note: If you do not see the Application Data directory, the directory may 
be hidden and you must show the hidden files. See Showing Hidden Files 
on page 100.

3. Copy the database file, DataPro_104.db3, to a backup location.

Note: If you upgrade from Bio-Plex Data Pro 1.0 to 1.1, you will see the 
database file for Bio-Plex Data Pro 1.0, DataPro_102.db3. We recommend 
that you back up this file as well.

Showing Hidden Files

If you do not see the directory specified in the database path, the cause may be that 
the directory is hidden from view. You must display the hidden directory before you 
can back up your database.

To display hidden files

1. Go to the Windows Start menu, select Settings, and select Control Panel.

2. Click Folder Options.

3. In the Folder Options dialog box, click the View tab.

4. Under Advanced Settings, click Show hidden files, folders, and drives.

5. Click OK.
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Glossary
Analyte The substance being measured, identified, quantitated, or otherwise 
analyzed in an experiment. In the Bio-Plex® system, analytes are 
molecules that are being quantitated.

Attribute Custom field relevant to customer research, entered manually or 
copied in from another list (Excel, for example).

Concentration The amount of substance present in a sample, usually expressed in 
weight per volume.

Data set The sample and analyte information available after a run has been 
performed and analyzed. A data set is roughly equivalent to a plate and 
is imported via a file import; for example, from Bio-Plex Manager™ 
software via an RBX file.

FI Fluorescent intensity. A relative measurement of fluorescent intensity 
based on the median, a robust statistical measure.

Heat map Graphical representation of peak expression data. Each column of a 
heat map represents a spectrum, each row represents a peak cluster, 
and each cell represents a specific peak that is color coded to reflect 
its expression level. Displays relationships between samples and 
analytes.

LLOQ Lower limit of quantitation.

LOD Limit of detection.

Outlier Sample concentration derived from FI below the background value. 
Sample concentration that meets a user-defined criteria, including 
%CV, concentration above or below a certain range.
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P-value Statistical representation of the chance that the relationship being 
observed is observed by pure chance. For example, a P-value of 0.01 
means that there is a 1% chance that the relationship between the 
independent variable and the dependent variable established by the 
model does not actually exist

Plate Assay plate. Bio-Plex assay plates have 96 or 384 wells. The plate 
contains assay data.

Sample A solution of analyte standards or unknowns that, when added to an 
assay, will bind to the microspheres in that assay and be identified and 
quantitated by the array reader

UOLQ Upper limit of quantitation. 
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Analytes, filtering 85
Analytes, order of 86
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Bio-Plex Manager, importing data from 48
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Color Gradient command 61
Column, adding custom 34
Column, hiding 70
Compare by 79
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Copying data 93

Copying graphs 94
Copying heat maps 60
Copying plots 94
Creating a project 38
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Data row, copying 93
Data rows, combining 55
Data set import status 47
Data set name, changing 49
Data set, deleting 50
Data set, editing 49
Data Sets table 40
Data Sets table, copying 93
Data Sets table, description of 40
Data sets, number of imported 46
Data Transform command 61
Data, copying 93
Data, filtering 73
Data, importing 46
Data, importing, from Bio-Plex Manager 48
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E
Edit menu 26
Edit Samples/Add Columns view 31
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Editing commands 28
Editing merged data in Results table 58
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Importing data 46
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Importing data, status of 47
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Merge column 57
Merged data, editing 58
Merging data 55
Multi Analyte table 53
Multi Analyte table, filtering data in 73

O
Obs Conc 52
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One-way/ANOVA test 82

P
Perform Analysis/Create Charts view, filtering 

data in 74
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Plots, copying 94
Plots, exporting 94
Project name, changing 44
Project, creating 38
Project, editing 44
Project, opening a 41
Project, organizing 45
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Projects, importing 43
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RBX file 46
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Results table, synchronized with Sample table
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